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Introduction

In the early 1940’s, the Boeing Aircraft Company had just finished building the B-17 bomber and needed to supply a
flight manual that would show the performance and range of the airplane at various weights.  Because there was no way
to determine the efficiency of the propellers, Boeing’s test pilots took the plane to 20,000’, shut the engines off and
ran the plane through a time-honored glider-test procedure to determine the characteristics of the plane.  The absurdity
of this did not escape notice of Boeing’s management, who asked the Flight and Aerodynamics Department to see if
they could develop a better method.

A small team of engineers, under the direction of Edmund T. Allen, developed a method of performance testing and
analysis that was used for B-17, B-29 and other aircraft during WWII.  This method was described in the January 1943
Journal of Aeronautical Sciences.  The method is precise, and it has stood the test of time and technological
improvements.  This is the method that is used by virtually all of the major aircraft manufacturers to obtain the
performance data on their aircraft.  

The flight testing required by this method is astonishingly simple and can easily be done by anyone, but the analysis
of the flight data is an impossibly complex series of calculations.  While most of the calculations are easily done by a
computer, there have been three stumbling blocks—propeller efficiency, engine power and fuel flow—that have
prevented computers from being used to automate this process.  

We’ve overcome those problems and the result is Benchmark, the first program on any computer to automate the
process of flight test performance analysis.  In a matter of a few hours, you can duplicate the performance flight test
data analysis and charting that heretofore would have taken a trained engineer months of painstaking work.
Furthermore, Benchmark requires no engineering training to use—in fact, it makes this previously mind-numbing
process into an interesting exercise that’s actually fun.  

By using Benchmark, you will be able to generate flight manual charts for your specific aircraft, not a factory-average
machine, and you should also gain a deeper understanding into the efficient operation of the aircraft.  

Benchmark includes:

• Complete database management with easily mastered data entry and editing.
• Instrument data correction by curve-fitting a polynomial to the data of actual vs indicated.  
• Pitot-static system correction by curve-fitting a polynomial to the data of Vias vs Vcas.  
• Atmospheric calculations.  
• Calculation of propeller efficiency in precise agreement with the Boeing General Propeller Chart.  
• Calculation of engine power output at any altitude or temperature.  
• Limiting manifold pressure for continuous operation.
• Induction system ram recovery.
• Analysis of drag polar flight test data and calculation of Cdo and Oswald E.
• Calculation of engine fuel consumption for full rich, best power and best economy mixture

settings.  
• Calculation of aircraft performance at any altitude, temperature or weight, or power setting.
• Production of camera-ready charts for aircraft flight manuals, including miles-per-gallon charts.
• High-resolution Encapsulated PostScript graphics output for editing with graphics programs such

as PowerDraw and Adobe Illustrator, and inclusion with electronic publishing systems such as
PageMaker, Microsoft Word, and others.

As it now stands, Benchmark is not the program we would like it to be.  There are many additional features we plan to
add to the program.  The most immediate things to add are printing for all of the dialog boxes that have a print button.
We also have some work to do on smoothing out some minor things.  

We plan to add engine power charts in a variety of forms.  We’d like to add sawtooth climb tests, but we are presently
unsure about how to integrate the results into Benchmark’s calculations of performance.  We’d like to add takeoff
charts, but we don’t know how to do that yet.  There are a number of range vs altitude charts that we’d like to do.  The
propeller efficiency charts need some controls in the dialog box.  
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In developing Benchmark, we’ve concentrated first on getting the job done and have left the nuances of interface design
for a later date.  You will note that when you open a Benchmark document, a window comes up with the name of the
document, but other than that, it doesn’t do diddly.  So if you feel offended by not seeing a click-and-drag window with
an elegant Macintosh interface, please hold your fire and give us time to get all of the features into the program before
we tackle that part of it.  

There are a few things about the way Benchmark works that we should explain.  

• Benchmark is a highly modal program.  This makes the management of extremely complicated
data structures possible and allows for a tightly controlled sequence of operations.  This is
sometimes frustrating, but allows us to achieve trouble-free operation without going  mad.  

• The data entry of numbers is tightly controlled.  This keeps you out of trouble, but it’s sometimes
irritating to have Benchmark watching your every keystroke.  Every entry of a number has a high
and a low limit, and in a few cases those limits are rather close together.  In those situations, you
may find that you must change a number a single character at a time.  

• The behavior of the text insertion cursor during the rejection of a number is, well, kludgy.  We’ve
tried a number of methods to get the selection range of a dialog boxes text edit records and so far
nothing has worked.  There are no built-in routines in the Macintosh toolbox that handle this
situation.  

• Because of space limitations in the dialog boxes, we’ve implemented something we call “toggle
buttons” instead of using several radio buttons.  A toggle button has a distinctive border, and it
changes its name every time you click on it.  We rather like the way they look and feel, and hope
you agree.  

Benchmark is the result of years of work.  I began work on it in 1986, and I’ve spent countless hours on the program.
The size of the program is astonishing, when you print out the program it weighs three pounds and stretches for the
length of a football field.  We did not copy-protect Benchmark because I hate copy-protection as much as you do and
we wanted Benchmark to be convenient to use.  Please don’t duplicate Benchmark for others to use.  They should
purchase their own copies of Benchmark, just as you did.  

I’m always open for any suggestion you might have for adding things to Benchmark.  Please, please, please submit
these ideas in writing.  Think your idea out carefully.  Explain what you want to accomplish and then give me some
idea of how you think it might be handled from the standpoint of user-interface or dialog box design.  If there’s some
math involved, please let me have that as well.  

I should tell you that there are absolutely no undocumented features to Benchmark, and we have made every effort to
document the program fully.  If we’ve failed, please tell us what parts confuse you, but please do not call for “technical
support” as an alternative to reading the manual.  

Special thanks to Fen and Dorothy Taylor who are both aeronautical engineers specializing in the performance testing
field and from whom we got this technology.  I’m also deeply indebted to Jim Petty, who has a remarkable ability to
turn a problem into an equation.  Many thanks to Hoyle Fulbright, Bill and Todd Stanley for their assistance on
programming problems.  Finally, thanks to Borland International for Turbo Pascal for the Macintosh—a remarkable
product—and for their Turbo Pascal Tutor, the best introductory book I’ve read on programming and which got me
started.  

I hope you enjoy using Benchmark and that it will increase your understanding of the efficient operation of your
aircraft, but please don’t let it loll you into taking chances with low fuel situations.  Always remember that the
calculations produced by Benchmark are not reality.  Your airplane is reality, and it is essential that you confirm the
accuracy of Benchmark’s performance predictions before you depend on them.  Take care of yourself.  

Alfred P. Scott
President
Sequoia Aircraft Corporation
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Chapter 1
Curves, Computers and Curve-Fitting

Data and Curves
Engineers, scientists and statisticians have faced an age-old problem with curves as a method of predicting the behavior
of phenomenon.  This might be the relationship between the population of red-headed people and the consumption of
pomegranates, or the frequency of sunspot behavior to changes in the weather.  

You can spend a lifetime gathering data on red-heads and pomegranates and looking in vain for a statistical relationship,
but sunspots are quite a different matter.  Sunspot activity increases dramatically on 11- and 22-year cycles and
scientists have noticed that there is a corresponding drop in rainfall during these periods—the Oklahoma dustbowl of
the 30’s coincided with one of these peaks of sunspot activity.  

But the problem is that daily sunspot activity and rainfall are highly irregular.  And to complicate matters, rainfall is
seasonal, and when we talk about 11- and 22-year cycles of sunspot activity we’re actually rounding things off a
bit—sunspots do their thing without any regard to where the planets are in their paths around the sun.  

If you study such things, sometimes you can find a relationship by plotting the data as a series of points on a chart and
just looking at it—“Look at this, Miss Mergatroid, red-heads do eat more pomegranates in August and September!”
Once you have found a neat relationship of data, the next thing you want to be able to do is to predict this behavior.  

Polynomial Equations
When the relationship is a simple curved line, a method that is frequently used with computers is fitting a polynomial
equation to the curve.  A polynomial is simply an equation that looks like this:

Y = A + BX + CX2 + DX3 + EX4

In this example, the letters A, B, C, D and E are the coefficients.  These are simply numbers that are calculated by an
excruciatingly convoluted and repetitive process to make the equation fit the curve, as best can be done.  You don’t
need to worry about these numbers, Benchmark will calculate them for you.  

What you do need to understand is the order of the polynomial.  Note that as you move to the right of the equation,
each expression of X has a larger exponent.  Polynomials can be of any length that you want, you just keep adding
more expressions of X with each one raised to a higher power—continue this higher power business long enough and
you will eventually see God.  In the example above, the largest power that X is raised to is 4, and for this reason, the
“order” of the polynomial is 4.  

Although polynomials may be of any order, in Benchmark they are limited to the range of 0 to 10, which as you will
see is more than enough for our purposes.  Because you will be selecting the order of the polynomial to use, you need
to understand the kinds of curves that these equations produce.  It’s quite simple.  

Polynomial Order of 0
Because the order of X is zero, the value of X has no influence on the value of Y, and X disappears from the equation
completely.  A polynomial with the order of zero is the ultimate over-simplification and rarely is useful.  Here’s an
example:

Y = 3

There’s no X in this equation at all, so Y always equals 3 regardless of the value of X.  This polynomial is simply an
average of all of the Y-values in the data.  The “curve” that this equation will generate is a simple horizontal
line—almost always useless for our purposes.  
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Polynomial Order of 1
A polynomial with the order of 1 looks like this:

Y = 3 + 5X

This is straight line.  A simple linear relationship.  If the data falls on a straight line, then you should select this order.  

Polynomial Order of 2
A polynomial with the order of 2 looks like this:

Y = 3 + 5X + 4X2

Now this one is a curve!  

It’s also the choice you’ll most often be making in Benchmark.  You probably have heard that when you drop an
object in a vacuum, the speed increases with the square of the time (32 feet per second squared) or that the drag of an
airplane goes up with the square of the speed, or Einstein’s famous E = MC2.  Whenever you are talking about speeds,
you are almost always talking about things that increase with the square of the speeds.  That’s just the nature of
physics—and to answer the question of the kid on the front row, there’s no why to it.  

So whenever you are dealing with a polynomial that is intended to represent something that is a function of speed, you
should always give a heavy preference to the second-order polynomial, even if the disparity with the data is greater than
with an higher-order polynomial.  The disparity is most likely to be in your data.  All of the curves relating to the
engine—friction horsepower, maximum horsepower, maximum manifold pressure, and fuel flow—fall into this
category, and you should have a good idea about the kind of curve that should be generated.  

High-Order Polynomials
These include polynomials from the order of 3 to 10.  As the order of the polynomial increases, you will notice that
the curves tend to snake back and forth and become more “violent”.  Because of the way the coefficients are calculated,
you will find that these curves will often do a superb job of passing through the data points, but they will usually go
crazy between these points and for values of X that are “outside” your data.  

There is a relationship between the number of data points and the order of the polynomial.  Polynomials tend to go
wild when there aren’t enough data points.  If the number of points is less than or equal to the order of the polynomial,
you have a disaster on your hands, while if the number of points is much greater than the order of the polynomial, it’s
likely that the polynomial will be very well behaved within the range of the data.  This is something that you can see
quite easily when you look at the curve; in fact, the process of selecting polynomials can be a certain amount of fun.  

Use these high order polynomials only when there are a lot of data points and when you know that the curve has no
basis in physics, such as when calibrating an instrument.  

Error, Max Error and RMS Error
Once the polynomial is calculated, Benchmark will go through all of the data points and compare the values that the
polynomial will generate with the original data point.  The difference is the error.  

These are too many numbers to have to look at, so Benchmark narrows this down to the maximum error and displays
this, along with the point at which it occurs.  

The other error that is displayed is the RMS error.  This is something like a new, improved version of average, and for
reasons that escape us, it’s generally considered the best way to consider the overall error.  This is done by squaring
each error, adding up all of these numbers and then taking the square root of the errors.  This leads to the name “root
mean square” error which is abbreviated as RMS error.  

Some computer programs automatically select a polynomial with the smallest RMS error.  This is known as the Least
Squares method, but we prefer the Evil Eye Method—look at the curve and decide for yourself if you think the curve
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accurately represents the data.  Sometimes the data will be badly scattered, and it will be immediately apparent.  There
are also times when a high-order polynomial will draw a crooked line through the data points, but the curve outside the
data points will be way off the mark.  

The Curve-Fit Dialog Box
Whenever you need to fit a polynomial to a set of data, Benchmark uses the following dialog box:

This is the standard Benchmark Curve Fit dialog.  Benchmark will do a series of curve-fits on the data.  These are
polynomial equations from order 0 to 10.  As each polynomial is calculated, the curve is plotted on the screen.  This
makes for a lively display of the curves, and gives you a quick preview of each one.   

Once all of the polynomials are calculated, Benchmark will then pre-select a polynomial order, and the method is
frightfully simple: unless the order of 0 or 1 has a lower RMS error, the order of 2 will be pre-selected.  It is then up
to you to explore the other polynomials and decide which one you want to select.  You select an order by using the
Order popup menu.  When you click OK, the currently selected order will be assigned to the polynomial.  

To get a better view of the curve, use the Zoom In and Zoom Out buttons, which will vary in operation depending on
the chart shown.  

If you click on the Errs button, the following dialog box will appear:

This is an aid in selecting the polynomial with the least RMS error.  Because the errors of the highest and lowest order
polynomials will be so large, use the Zoom In and Zoom Out buttons to get a better view of the chart.  

If you click on the Poly button in the Curve-Fit Dialog, this will bring up the Polynomial dialog box, shown below.  
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This shows the polynomial coefficients of the polynomial being used, the RMS error and the maximum error.  
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Chapter 2
Instrumentation

Instrumentation and Calibration
About 80% of the bad data and repeat flight tests result from instrumentation problems.  It is essential that you use
instrumentation with known accuracy so that all variables can be measured correctly.  Always have your instruments
calibrated in a good instrument shop.  Make them plot the error against the indicator reading, at intervals as short as
your pocketbook can stand.  New instruments can have just as much error as old instruments.  Plot error on both the
increasing and decreasing mode for each instrument.  This allows for a hysteresis correction to your flight test data.
Beware of sticking instruments.  

The most important instrument is the airspeed indicator.  For the purpose of these tests, you should borrow or rent a
sensitive airspeed indicator—a two-handed instrument, like an altimeter, with a sweep hand readable in one-mph
increments.  Most instrument shops have one or two laying around.  Explain what you are trying to do, and you may
be able to elicit some sympathy and cooperation.  The sensitive airspeed indicator should be calibrated in 10-mph
increments.  

If you decide to use the airspeed indicator that is already installed in your plane, it’s quite easy to calibrate the
instrument yourself with a few dollars worth of plastic tubing.  You make a water manometer and change the pressure
with a squeeze bulb.  For each speed increment, you write down the column of water, in inches or millimeters.  

In the manual calibration method, you draw a chart of indicated vs corrected airspeed, first by placing points at each data
point and then drawing a smooth curve through these points.  This is something a computer does very well, through a
method known as curve-fitting.  In Benchmark, you enter the data points, and then the program calculates a series of
polynomials of various orders.  You choose the curve that best fits your data, and then the program will use that curve
to determine the corrected airspeed.  This process of fitting curves to data is central to the operation of the Benchmark
program.  

If you don’t calibrate the airspeed indicator and simply use the one you have, all may not be lost.  The first flight tests
will calibrate the airspeed system.  With a calibrated airspeed indicator, this flight test measures the error of the pitot-
static system.  In the absence of the instrument calibration, the flight test will measure the combined error of airspeed
indicator and pitot-static system.  The flight tests will give you reasonably useful information—certainly more useful
than no test at all—as long as you keep the same airspeed indicator.  

The sensitive altimeter should be calibrated in 10’ increments from 0 to 200’, then in 200’ increments above.  

The OAT gauge is important.  Check the ice point at 32°F or 0°C.  Digital OAT indicators with remote sensors are
excellent.  For accurate data, the sensor should be shaded from the sun at all times.  This is quite important for
accuracy since pilots have reported seeing a 5°C difference on a run in opposite directions, just because of sunlight on
the sensor in one direction.  If you don’t make any changes, at least note the position of the sun on each run and use
only those temperatures with the sensor in the shade.  

Since aircraft tachometers frequently indicate lower and lower with age, the tach should be calibrated in 50-rpm
increments from 1500 to 2700 rpm.  A strobe tach is very accurate and can be used to calibrate the tachometer in your
airplane.  There are a number of digital tachometers which are now appearing on the aviation scene.  These are not
terribly expensive and are easily installed.  One digital tachometer uses an optical encoder on the inside of the starter
ring—a strip of reflective tape is placed on the inside of the ring and the encoder shines a light against the tape and
counts the number of reflections.  

Leak-check the system and gauge, and then calibrate the manifold pressure gauge in .5” increments.  These are
notorious troublemakers.  

A fuel totalizer that shows fuel flow and fuel used is best.  A pressure/orifice fuel pressure gauge will work if correctly
calibrated, although this is more difficult since it requires referring to the engine manufacturer’s fuel-flow-vs-fuel-
pressure charts and calculating the aircraft’s weight at each flight run—all of which is simple with a fuel totalizer.  
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If the aircraft does not have an accurate digital clock-timer, you will need a hand-held stopwatch to keep track of the
time during the flights.  

Aircraft manufacturers do all of these things for their flight tests.   We are well aware that you might not go to the
same trouble and expense, but now you know the proper way.

Do-It-Yourself Calibration
It’s very important that the airspeed indicator be calibrated.  While instrument shops have accurate equipment to
calibrate instruments, you can easily calibrate your airspeed indicator with a water manometer.  This requires nothing
more than a few feet of clear plastic tubing, a fitting to join the tubing to the instrument, and optionally a squeeze
bulb.  

It is very important that you do not allow any water to enter the airspeed indicator, or you could ruin it.  Make the
water manometer as shown and then apply pressure, either by using a squeeze bulb or by lowering the instrument.  For
each indicated speed, measure the column of water in inches or centimeters.  

To convert these inches of water or centimeters of water, go the the Calculate menu and choose Units Calculator.  The
following dialog box will appear:

The Units Calculator is provided to assist in the calibration of your instruments.  It shows the relationship between the
indications of an airspeed indicator, altimeter and manifold pressure gauge with a variety of pressure measurements.
The conversion is two-way, that is, you can type an indicated airspeed and get the equivalent pressure, or you can type
a pressure and get the equivalent indicated airspeed.  Use this calculator to convert the inches of water to the actual
airspeeds.  

Entering the Data
Once you have the data for an instrument, it is time to enter this into Benchmark.  

To create a new Benchmark document:
❏ Choose New from the File menu.  The following dialog box will appear:
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❏ Select Instrument to tell Benchmark that you want to create a new instrument file.  When you click OK, the
following dialog box will appear:

Type the information required.  Click OK.  

To enter the calibration data for the instrument, go to the Edit menu and choose Airspeed Indicator, Altimeter,
Tachometer, or Manifold Pressure Gauge (as appropriate) and a slightly different version of the instrument data dialog
will appear:

The Delete button is provided to delete the instrument from an aircraft file.  When you click OK, the following dialog
box will appear:

This is where you type the calibration data for the instrument.  See “Standard Benchmark Data Edit Dialog Box” on
page 10-1 for an explanation of the use of this dialog box.  

Fitting the Curves
The next step is to fit a polynomial to the instrument data.  Go to the Analyze menu and choose Airspeed Indicator,
Altimeter, Tachometer, or Manifold Pressure Gauge (as appropriate) and the following dialog box will appear:
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This is the standard Benchmark Curve-Fit dialog.  Benchmark will do a series of curve-fits on the data.  These are
polynomial equations from order 0 to 10 and will then wait for you to select the polynomial order which best fits the
situation.  To get a better view of the curve, use the Zoom In and Zoom Out buttons.  

If you click on the Errs button, the following dialog box will appear:

This is an aid in selecting the polynomial with the least RMS error.  Because the errors of the highest and lowest order
polynomials will be so large, use the Zoom In and Zoom Out buttons to get a better view of the chart.  

If you click on the Poly button in the Curve-Fit dialog, this will bring up the Polynomial dialog box, shown below,
which shows the polynomial coefficients of the polynomial being used, the RMS error and the maximum error.  

When you click OK, the currently selected order will select the polynomial that will be used for the instrument.  This
means that Benchmark will automatically correct any indicated airspeed, altitude, rpm or manifold pressure for
instrument data.  But to do this, the instrument must be “installed” in the airplane.  But first, select Save from the File
menu to save the document.  Later, after you have created an airplane file, you may install the instrument in the
airplane by choosing Install Instrument from the File menu.  
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Chapter 3
The Propeller

Data Entry
The propeller, at least from your view, is very easy.  There’s not much information that is needed in Benchmark.  

To create a new propeller document:
❏ Choose New from the File menu.  The following dialog box will appear:

❏ Select Propeller to tell Benchmark that you want to create a new instrument file.  When you click OK, the
following dialog box will appear:

Type the propeller manufacturer name, model number or name, and propeller diameter.  If the diameter is not in the
unit of measurement that you want, change it with the Inches/Centimeters popup.  

Blade Thickness applies only if the EHTS (equivalent helical tip speed—see Appendix A) goes over 1000 ft/second.
Unless you know that your propeller tip will be operating at those speeds, it is best to leave Blade Thickness set to
Average.  

Dual rotation propellers are exceedingly rare and haven’t been used in piston-engine aircraft since just after WWII, but
Benchmark has the ability to calculate the efficiency of such a propeller.  

The blade activity factor (described more fully in Appendix A) is very much like the aspect ratio of a wing, but because
the tip of the propeller travels through air faster than the rest of the blade, some adjustment must be made for this.
The propeller manufacturer can supply this information.  

Type the information required.  Click OK.  

Select Save from the File menu to save the document.  Later, after you have created an airplane file, you may install
the propeller in the airplane by choosing Install Propeller from the File menu.  

Calculating Propeller Efficiency
You can calculate the propeller efficiency with the Propeller Efficiency calculator found in the Calculate menu.  This
will calculate the efficiency of a propeller according to the Boeing General Propeller Chart.  

To use the Propeller Efficiency Calculator:
❏ Choose Propeller Efficiency from the Calculate menu.  The following dialog box will appear:
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If you have a propeller file open or have an airplane file open that has a propeller installed, the propeller specifications
will already be filled in.  Changing these does not change the specifications of the propeller file or propeller installed in
the airplane.  

Type in the boxes for Vtas, engine power, pressure altitude, temperature, propeller diameter, RPM, blade activity
factor, and number of blades.  The speed is also handled with a toggle button, click on the Vtas button to change the
speed to Veas.  (Remember, equivalent airspeed is indicated airspeed with no error—just think of it as “indicated”.)  

If ISO Standard is checked, the temperature for the ISO standard atmosphere is automatically calculated.  De-select ISO
Standard to type your own temperature.  Blade thickness applies only if the EHTS goes over 1000 ft/second.  When the
tips of the blades go supersonic, efficiency deteriorates rapidly, and thick blades do so quicker than thin blades.  

The propeller efficiency is plotted against for J/Cp^1/3 (abbreviated as J_Cp and J/CP in the dialog box) or Cpx
according to the setting on the Plot Eta Vs toggle button.  Click on the toggle button to change the setting.  When the
line is plotted as a gray line, this means that the values being plotted are outside the values represented on the Boeing
General Propeller Chart.  Similarly, any values that are not represented on the Boeing chart are shown in italics.  These
out-of-range values should should not be taken seriously.  The curves that are plotted are not simply the curves from
the Boeing General Propeller chart; they also include the other variables of ∆Eta TAF and ∆Eta TS—which make
adjustments for the total activity factor and tip speed.  

See Appendix A for a complete discussion of the calculations involved in propeller efficiency, but here’s an overly
simple explanation.  Think of J/Cp^1/3 as the speed of the airplane and Cpx as the amount of power put into the
propeller.  When you are plotting Eta vs J/Cp^1/3, change the speed and note how the efficiency moves along the
curve.  When you are plotting Eta vs Cpx, try changing the amount of power or the number of blades and observe how
the efficiency moves along the curve.  If the propeller is properly selected for the engine/airspeed combination, you
should find the propeller efficiency near the peak of both curves.  
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system will increase exponentially as the flow of air increases, but on the positive side of the ledger, the turbocharger’s
ability to pump more air will also increase exponentially with the rpms of the engine, and this will be the more
powerful of the two forces.  

Entering the Manifold Pressure Limit

Power 2

MAP1 MAP2

Power 1

limiting manifold pressure
for continuous operation

Many engine sea level charts have a straight line called “limiting manifold pressure for continuous operation” as shown
above.

For What It’s Worth Department.  The purpose of this line, ostensibly, is to keep you
from lugging the engine and damaging it.  In some cases the manifold pressure limit is related to
an engine vibration mode, and in most such cases, this reason is noted on the chart.  In most other
cases, the limit is related to detonation.  In developing Benchmark, we were curious if this line
was a line of constant BMEP—it isn’t—or some other calculable function.  

An engineer at Lycoming was delightfully candid—“We have no idea where the line came
from”—and said that all of his attempts to back into a rational basis for the line have been
unsuccessful.  (Remember, four-cylinder Lycomings were developed 30 years ago, and the engineer
who drew the line retired long ago.)  The engineer also pointed out that on some of their larger
engines, the turbocharged versions are regularly operated above the limiting manifold pressure for
the otherwise-identical normally aspirated engine.  

Detonation is a function of BMEP, RPM, temperature and the fuel/air ratio.  It’s possible that a
very bright engineer studied the problem and concluded that this line provided a safe limit that
would reliably keep you out of detonation, but it’s equally possible that the line is arbitrary; that
an engineer simply slapped a ruler on the paper, drew a line, and muttered to himself, “That ought
to keep the idiots out there out of trouble!”  Whatever the rational for the line, in Benchmark, we
simply treat the limit as a linear relationship between manifold pressure and engine power—a line.  

Using the engine manufacturer’s engine chart, locate two points on the manifold pressure limit line, then choose
Manifold Pressure Limit from the Edit menu.  The following dialog box will appear:

Type the numbers required.  Almost no error-checking is presently performed on the numbers: point 2 must be above
and to the right of point 1.  To have “no line”, i.e. no manifold pressure limit, zero all of the numbers.  
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Entering Fuel Flow Data
Benchmark has the capability of modeling the fuel flow of the engine.  Like engine power, this is handled by fitting a
polynomial to the data, but in this case the data is not a curved line, but rather a curved three-dimensional shape, just
like propeller efficiency, so the curve is represented by a multivariate polynomial.  

Benchmark models fuel flow for three mixture settings—full rich, best power and best economy—thus it requires three
sets of data, represented by fuel flow vs engine power and engine rpm.  You get this data from the engine
manufacturer’s charts.  Most manufacturers show the best power and best economy fuel flow in the form needed, that
is, they chart fuel flow vs engine power for lines of constant rpm.  

With the data for full rich, engine manufacturers often plot the fuel flow vs manifold pressure for lines of constant
rpm.  This is easily handled by using Benchmark’s Engine Power calculator to convert those manifold pressure/rpm
settings into the desired power/rpm data.  If you have a fuel totalizer, you can also just go fly your plane, set the
mixture at full rich and write down the numbers at various power settings.  

Once you have written down all of the fuel flow data required, select Full Rich Fuel Data, Best Power Fuel Data or
Best Economy Fuel Data from the Edit menu, and the following dialog box will appear:

Enter the data required.  See “Standard Benchmark Data Edit Dialog Box” on page 10-1 for an explanation of the use of
this dialog box.  

If you are editing the best power or best economy fuel data, when you click OK, the following dialog box will appear:  

Most engines have a maximum power above which best power or best economy leaning is not permitted.  This
number is used by Benchmark in the engine power calculator, in the airplane speed calculator and in some of the
performance charts.  Enter the maximum power for best power or best economy leaning.  

Analyzing Engine Fuel Data
Because there are three sets of data, you have to follow this procedure three times.  From the Analyze menu, choose
Full Rich Fuel Consumption, Best Power Fuel Consumption or Best Economy Fuel Consumption.  The following
dialog box will appear:


